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Welcome to Leo Backup 

In this tutorial you get to know how to work with the Leo Backup program step-by-step. 

This tutorial consists of five parts. 

In the first part, you will get the main information about Leo Backup: the product overview, its 
feature description, system requirements, installation and registration procedure. 

The second part will show you how to work with program elements:  Leo Backup Wizard to get you 
started and the main steps to backup and restore your data.

In the third part you will learn the program Interface and its menus commands. 

The final fourth part contains the legal information, so please read carefully the End User License 
Agreement.  You can find the contact info in this part as well. 

Happy journey to Leo Backup! 

Product Overview

Leo Backup is the program for backing up and restoring any files on your system and network, 
including the particular file types (profiles, registry, mails, contacts, etc.).

The new secure options thoroughly protect your backup management and provide you with exact 
safe transferring of files. 

The “Set it & Forget it” gear allows for a fast and simple backup: the built-in Scheduler makes your 
backup plans feasible on its own, the Incremental backup option gives you the choice to manage 
your files, the Timestamp feature makes for convenient  files collection and its fast retrieval, and the 
Filtering and Compression facet reduces your time and space storage. 

This is the opportune utility both for personal and corporate usage. 

http://www.leo-backup.com
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Key Features

•	 Different storage types – Leo Backup supports the various data storages:

•	 Remote FTP, secure FTP (SSL/TLS) and SFTP servers
•	 Network drives including SAN, NAS and LAN locations
•	 External and Internal hard drives 
•	 All types of flash memory devices and removable media gadgets.

•	 Security – Secure protocols support (FTP with SSL/TSL and SFTP), interface password, 
special authorization methods, and files encryption provide you and your company with an 
indispensable safety level. Be sure that your data is well protected; use the extremely covered 
backup methods and don’t worry about data leakage. 

•	 Different files types to be backed up – You can preserve all of your files with our backup 
engine. Furthermore, there are a number of standard programs like mail clients or messengers 
that deal with important information. Rather often, these files remain as not backed up and it 
could provoke a lot of troubles. However, now you can easily arrange the backup of these data 
via one simple command. It is also easy to back up the .reg files from Registry.

•	 Full and Incremental Backup – Leo Backup applies the possibility of Incremental backup 
to work with files. With this approach the program backs up only new or modified files 
and therefore skips the files if they haven't been changed since the last backup session. 
Incremental backup allows you to reduce the time to complete your backup tasks and keep 
your processed files up-to-date.

•	 Scheduled Backup – Automatic backup scheduling is a way to ensure that the data are being 
backed up on a regular basis without your interference. Moreover, backup of large data 
amounts often require an additional system load and it can provoke the activity interruption. 
With the Scheduler option you can avoid these problems by launching the backup process at 
the most convenient time. 

•	 Files Encryption – Leo Backup uses AES-256 encryption to store backup data securely and to 
ensure that only you are able to access your data. AES-256 is a symmetric block cipher that 
takes 256-bit password key, making it ideal for both personal and office use. 

http://www.leo-backup.com
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•	 ZIP compression – The built-in ZIP compression increases the backup speed and saves the 
storage space on your drive. Choosing between three options («Zip Each File» independently, 
«Zip Each Folder,» or «Single ZIP» file) you can organize the backup files structure in the most 
appropriate way. Thanks to the non-proprietary Zip format your files can be manually restored 
with any zip-compatible utility. 

•	 Pre and Pro running – You can easily adjust your program’s functionality to your backup 
plan by launching the backup task before or after a program client’s run to avoid any 
incompatibility, system hanging or surplus resources consumption.

•	 E-mail Notification – The convenient feature to inform the user about the backup status is by 
e-mail. This feature can be especially useful for network administrators who have to back up 
tons of data and also control multiple backup processes.

System Requirements

These points are recommended as minimums for running Leo Backup:

•	 Microsoft Windows XP/Vista/Windows 7/Server 2003/Server 2008 
•	 3Mb of free disk space (additional free disk space may be necessary for storing backup files).

Installation

The installation process does not require any special knack; just run the program and follow the 
on-screen instructions of the Wizard.  Then just run Leo Backup – it does not require the system to 
be rebooted. 

The trial version is active during 30 days. Then please visit our Ordering page to purchase the full 
unlimited version of Leo Backup.

Uninstallation

1.	 Click the Start button, select Settings, select Control Panel, then select Add/Remove Programs.
2.	 Choose Leo Backup from the list and click the Remove button.

Note: The uninstall function will remove from your computer all the files associated with Leo Backup. 
The program icon will also be deleted from your desktop.

http://www.leo-backup.com
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Registration 

Upon completion of your purchase, you will receive the registration key by e-mail. Then please 
register Leo Backup following the procedure below: 

•	 Go to the Help menu 
•	 Click the «How to Register» command 
•	 Enter the registration key 
•	 Press a button to register online or via e-mail.

You will get a confirmation message that the registration was successful. 

NOTE:  The online registration is concerned with your Internet, so in the case of an unstable connection 
you can register the software by e-mail:

•	 After entering your serial number (review the registration instruction below), choose the 
“Registration by e-mail” button.  

•	 Your default e-mail program will open a message with proper information and e-mail address, 
so just send it then.

•	 If you do not use the default e-mail, please copy the text from the message box, paste it in your 
e-mail client message and send it to registration@leo-backup.com  

You will receive the special registration file with instruction as soon as your message is processed. 

http://www.leo-backup.com
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How to Operate with Your Data 

Start

When running Leo Backup for the first time you will see Wizard helping you to configure your new 
backup set. Just choose the proper operation on the first screen of the wizard:

Back up your data – to create new backup set and configure backup features as its destination, 
compression, scheduling, etc.

Restore previously backed up data – to restore the previously backed up data from the chosen 
location.

Depending on your choice, you will proceed with Backing up Data or Restoring Data.

Backup

Step 1: What to Backup

The following steps will show you how to set your backup set:

Creating New Backup Set 

Click the “New backup set” button on the Toolbar (or go to File menu > New backup Set):

Please type the Set name and click ‘Next.’

Adding the data: 

Click the ‘Add’    button and select the files/folder you want to back up. Together 
with common files you can also select the particular types of predefined data sets: Windows Profile, 
your messengers, e-mail program, web settings and Registry keys:

http://www.leo-backup.com
www.s5development.com


User Guide

9 www.leo-backup.com S5 Development LLC

Filtering

Here you can include or exclude some files and folders from your backup set: use the ‘Filter 
Settings’ command and put the checkmarks to exclude/include the proper file types:

You can specify several file masks separating them with ‘;’.

Remove

You can remove any file or folder from the backup set by clicking ‘Remove’ button.

http://www.leo-backup.com
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You can also manage the files from your backup kit by placing/removing the checkmarks of the files in 
the list.

And then we’re going to the Next step: Where to backup

Step 2: Where to Backup

On this step please specify the backup location and its properties. There are four destination types:  

•	 Local/Network Disk 
•	 FTP server (including the FTP with SSL/TSL algorithms) 
•	 SFTP server
•	 Amazon S3 server

1. Local/Network Disk:

 Please click the ‘browse’ button below and specify the proper location for your backup task:

http://www.leo-backup.com
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You can connect by applying the different user name: 
In this case the backup will be located on the network share that requires authentication, so please 
specify the accessing data here.

 

2. Standard FTP server and FTP server with SSL/TLS  

You can set the backup of your files over the standard FTP or over the FTP with a special secure 
extension, so first  please select the proper one: 

SSL/TLS (Secure Sockets Layer, Transport Layer Security) provides one of the most commonly available 
security mechanisms. This is the FTP protocol extension that guarantees the secure connections for 
transferring the most valuable data.

http://www.leo-backup.com
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Then please fill in the following fields: 

*	 FTP Server Address and Port
*	 User – specify user login for accessing 

FTP Server
*	 Password – specify User password for 

access
*	 Folder – specify remote folder on FTP 

to store your data (use the Browse 
panel to select). 

*	

3. SFTP server

SFTP, the network protocol based on SSH (Secure Shell), is an efficient opportunity to securely 
manage important file transfers within your office/network. This protocol guarantees the ultimate 
protection of the authenticity, confidentiality and integrity of data transferring. 
When you are going to backup your data to the SFTP server, you need to specify the same points as 
indicated above, but you also  can apply the following advanced options:

*	 Public Key and Private 
Key: Here you may apply 
the special related key pair: 
a secret private key and a 
published public key.  

*	 Passphrase: please specify the 
prescribed passphrase.

http://www.leo-backup.com
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Step 3: How to Backup

The program offers you several options to adjust your backup set.

1. The Full /Incremental backup

*	 ‘Full backup’ option enables the backup of every file, whether that file has changed or not. 
*	 With the ‘Incremental backup’ option checked the program will back up only those files that 

have been changed since the last backup of any type. This provides the quicker backup, since it 
makes copies only of files that have not yet been backed up.

The Incremental backup option is active by default. At the first backup operation the backup will be full 
even with ‘Incremental backup’ checked. 

Please note the Single ZIP rule related to Incremental backup possibility! 

2. Compression

Here you can manage your data compression and its structure. With embedded ZIP technology 
you can archive your files, increasing its size to keep the storage space and to lighten your traffic 
load.

You can choose the compression option as you would like to:

*	 No Compression – all your data remain as is, 
*	 Zip Each File –each file will be zipped and backed up independently,	
*	 Zip Each Folder –all files within each folder will be zipped into a single archive,
*	 Single ZIP – your files and folders will be archived into a single zip.

Please note that by applying the Single ZIP option you cannot activate the Incremental backup 
command due to the ZIP file format.

http://www.leo-backup.com
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3. Encryption 

The built-in Bruce Schneier’s invention, Blowfish encryption, allows you to apply the secure 
cipher for full data set to protect it from any unauthorized admittance. 

Here you can either not apply the encryption to your files, OR turn on the Blowfish encryption 
method. 

4. Timestamps

With the Timestamps option you can automatically mark the particular folder and therefore 
avoid too large data accumulation due to frequent backup and tangled assortment of files and 
folders. 

On this pane you can manage the timestamps mode for your backup kit according to date and 
time, and also add your own lable. 

*	 For instance, you select the ‘Year-Month-
Day-Hour’ format and the backup operation 
takes place at 1 of April 2010, 5PM. Then, 
your backed up set will  look like “2010-04-
01_17hour”:   you can easy find it in through 
the destination 

Thanks to Weekly timestamps it is easy to mark the newly made backup set by the weekday when it 
was performed to retrieve it in the destination folder properly. 

http://www.leo-backup.com
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Step 4: Scheduler

The Scheduler option allows you to set the backup procedure on automatic mode. Just specify the 
desired date and time using the calendar and multiple configurations:

*	 Run backup at – choose date 
and time when backup should 
be started. The backup set 
won’t be launched prior this 
moment.

Recurrence Options:

Please specify the preferable options for your backup scheduler:

*	 One Time - to start backup once at 
date/time specified

*	 Daily - to backup your data on a daily 
basis at the time specified

*	 Weekly - to backup data on specific 
days of the week

*	 Custom – to run backup periodically 
at an interval defined in hours, 
minutes and seconds.

http://www.leo-backup.com
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Step 5: Additional Settings

On this last step you can manage the special settings for a particular program’s launch and report 
of the backup results: 

1. Pre/Pro-configured backup sets: 

*	 Run program before running 
backup – specify the path to execute 
the prior running backup. Backup 
won’t start until the specified 
program is finished.

*	 Run program after backup – the 
program runs only when your 
backup set is completed.

http://www.leo-backup.com
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You can choose the appropriate method of running those programs:
 

- Run under Current account – will launch the program commands under the user account if the 
user is currently logged in

or

- Run under System account – will run the commands under the System account.

2. Backup results Reporting:

 You can set your e-mail details and receive the E-mail notification of your backup status.

By default the program generates the notification about any backup operation. So you can check 
the ‘On Errors Only’ option to receive notifications only in the case if some error occurred.

You can have the whole operation log file on your e-mail notification. Please note that in order to 
save your space and time, the program archives the log files in the ZIP format. 

http://www.leo-backup.com
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Step 6: Backup the Set

As your new item is completed please click OK and then the Backup button.  

Now your data are saved. 

You can always check the backup status in the Log in the Summary (Log) panel.

 

So our next step is to restore your data. 
Let’s go there.

http://www.leo-backup.com
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Restore 

Step 1: What to Restore 

There are two restore methods: 

1.	 Restore of the sets located in the Leo Backup list, 
2.	 Restore of your backups from scratch

NOTE: the latter variant is applicable to the cases when the program/system reinstallation took  place 
and therefore your backup sets are not visible on the Leo Backup interface. But you can restore your files 
anyway with the help of Restore Wizard. 

1. To restore your backup sets files from the list: 

*	 Just right-click on your backup 
set and select the ‘Restore 
Selected’ command. 

*	 ‘Restore Selected To’ command 
lets you choose another 
restoring location for your item. 

*	
*	

2. To restore your backed up files afresh please run the Restore Wizard: 
go to ‘File’ menu and select the ‘Restore Wizard’ command.

http://www.leo-backup.com
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To restore the file target please select the disk or server where your file is located. The program 
should find the special backup files (.bcd) automatically.

Then specify other characteristics (either browse for proper disk folder or indicate the server 
points):

 
   
Step 2: Where to Restore

On the next dialog window please select the restoring location and the data to be restored:

http://www.leo-backup.com
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Advanced Options

There are several additional options in the Tool menu to arrange the program functionality 
properly:

Save and Load Configuration

You can save the whole backup set collection into a simple .zip file. Then you can restore it into the 
program using the Load Configuration command.

Open Remote Backup

This option lets you obtain the data located remotely.  It is a useful command in the case when 
your large backed up data were manually transferred on some remote location. 
With the ‘Open Remote backup’ option, you can simply connect to this remote direction and work 
with your backup sets (add and remove the files, edit scheduler or compression settings, etc.). 

Cleanup «Missing in Source» Files

Cleanup «Missing in source» files uses to check the backup source and destination to make both 
source and destination sets identical by removing the extra files, i.e., the files from the destination 
that has no matching pair in the source.

http://www.leo-backup.com
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Password Protection

With this command you can create the interface password – it will let you avoid the risk of 
unauthorized use of your program copy and protect your data. 

You can also edit and remove the existing password. 

Toggle Service Mode 

Running program as a service means that the program automatically makes a backup at the time 
specified even if no user is logged on. That might be the efficient option for the servers’ backup 
administration or for the tasks scheduled to be performed at night, for instance.

http://www.leo-backup.com
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Interface 

Interface Summary 

This section will show you several interface panels and its commands:

•	 Program Menus 
•	 Toolbar
•	 Backup sets List 
•	 Summary pane 
•	 Log details
•	 System tray Icon
•	 Explorer Integration
•	 Command line

Program Menu

There are a few menus at the upper part of the Leo Backup interface with multiple commands: 

 

File 

•	 	New Backup Set: initiates the backup wizards to 
create the new item. 

•	 Duplicate Backup Set: makes a copy of selected 
item. 

•	 Backup: to run the backup operation. 
•	 Restore Wizard: lets you restore your backup set 

from scratch. 
•	 Backup Selected, Restore Selected, Restore 

Selected To: these commands are applied to the 
files selected in the ‘Backup Set’ window; you can 
backup and restore the individual files from the 
whole backup kit then. 

•	 Stop: this button is active during the backup 
process, so that you could stop the backup 
operation at any moment. 

•	 Backup Properties: opens your backup set features 
to be viewed and edited. 

•	 Delete Backup Set: erases the whole backup set. 

http://www.leo-backup.com
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View

This menu lets you manage the appropriate interface mode (you 
can add or remove some program bars as Toolbar, Status Bar and 
Summary Pane) and adjust the logging;  you can clear the old 
logs from the view and set the log details representation  from 
Medium to Full. Also you can dispose the program to show only the 
operation errors in the log.

Tools

Using the ‘Tools’ menu you can:

•	 Save and Load backup configuration 
•	 Open remote backup 
•	 Clear the missing in source files 
•	 Set the program password 
•	 Toggle the service mode 

           

Help

The ‘Help’ menu shows you all the points related to information and assistance:

•	 Content opens the Help guide about Leo Backup 
usage that you are reading now.

•	 You can also read about the program on our webpage: 
just click the ‘Leo Backup on the Web’ command. 

•	 Support Request opens an e-mail message to be sent 
to our technical team, so you can easily commit your 
demands if there are any problems and/or questions 
about Leo Backup’s functionality.  

•	 How to Purchase option will lead you to our ordering 
page where you can buy the serial number for Leo 
Backup.

http://www.leo-backup.com
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•	 How to Register option will open the window to enter your serial number to obtain the 
registered version of Leo Backup.

•	 About Leo Backup shows the program version with upgrade link and your registration status.  

Toolbar

The program toolbar contains the commands related to your operation:

 

•	 New Backup Set — opens the New Set wizard to help you create a new set of data for backup. 
•	 Backup — will perform the backup operation of the selected set or file 
•	 Refresh — refreshes the backup set and checks for any changes made 
•	 Stop — button stops the backup/restore running operation 
•	 Properties — open your set features to be viewed and edited 
•	 Register — this button is available only while you are using the trial version of the program. 

Backup Sets List 

On this pane you will see the list of your existing backup sets with its status:

symbol means that this set is backed up successfully
symbol means that there were some errors during 
backup
symbol means that this set is in process

By right-clicking on the set you can open the backup set properties dialog, add new data to your 
backup set, perform the backup and refresh operations or delete the selected set.

Double-clicking on the selected set will open the Properties dialog.

http://www.leo-backup.com
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Summary Pane

Summary pane reflects all the features of the set selected: 

•	 Backup destination 
•	 Compression type (if enabled) 
•	 Encryption (if enabled) 
•	 Scheduler info (if enabled) 
•	 Last Run Time 
•	 Next Run Time (if scheduler enabled) 
•	 Identical – percentage of backed up files

Log Details 

The lower pane of the program interface shows all operation events, related to a selected item like:

14:36:34		 Backup Started. (2010-04-21)
14:36:34		 Destination: [LAN] C:\Documents and Settings\XXX\My Documents\backup test\; 
Zip Folder
14:36:34		 Looking for changes.
14:36:34		 Estimating backup size.
14:36:34		 Estimated backup size is: 1797698.
14:36:34		 ====================================================
14:36:34		 Saving backup data.
14:36:34		 Closing transfer engine.
14:36:34		 Backup finished successfully.
14:36:34		 Backup Finished. (2010-04-21)

By right-clicking on the log pane and 
choosing the proper command from the 
context menu, you may 
   - copy the log text, 
   - clear the log field, 
   - change its details. 

 

http://www.leo-backup.com
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System Tray Icon 

Leo Backup’s agent icon is shown in the system tray, indicating that Leo Backup is running.  

 The green mark on the icons means that some operation is taking place at the moment.

Available commands:

- Double-click: open the program interface
- Right-click: 
             - Run backup of all sets;
              - Stop the backup operation(s)
              - Shutdown Leo Backup. 

Note that when you exit the Leo Backup agent, your running backups will remain uncompleted and all 
scheduled tasks will not be performed until you rerun the program.

Explorer Integration

You can manage your backup data right from the Explorer menu. Just select the proper file/folder 
to be backed up and find the “Add To backup Set’ command from the context menu.

From the next menu you can choose the set where you would like to add the selected data.

 
Command Line

Leo Backup can be operated through the command line interface. Command line should have the 
following format:

LeoUI.exe [/PARAM [value] …]

http://www.leo-backup.com
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The available command line options are:

•	 /INCLUDE   –  add data from path specified to the backup set 
•	 /EXCLUDE   – remove specified data from the backup set 
•	 /BACKUP – start backup operation 
•	 /STOP – abort current operation 

Note: These commands (/INCLUDE /EXCLUDE /BACKUP /STOP) are related to the backup set, so it is 
necessary to apply the «/set < Backup Set Name >» rule here. These commands will not work without 
this prefix.

Examples:

LeoUI.exe /set «Backup Set Name» /INCLUDE «C:\Documents\» – will add «C:\Documents\» folder to the 
backup set
LeoUI.exe /set «Backup Set Name» /BACKUP – will start the backup process in background.

Also you can operate the following commands:

•	 /OPEN – open the program interface after processing command line operations 
•	 /HELP – show command line options 
•	 /? - show command line options 

http://www.leo-backup.com
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Licensing and contact information 

Licensing

S5 Development LLC

Leo Backup End User License Agreement

IMPORTANT NOTICE: This software end user license agreement («EULA») is a legal agreement 
between YOU and S5 DEVELOPMENT LLC. Use of the software provided with this agreement (the « 
SOFTWARE «) constitutes your acceptance of these terms. Read it carefully before completing the 
installation process and using the software. If you do not agree to the terms of this agreement, do 
not install and/or use this software. By installing, copying, or otherwise using the software product, 
you agree to be bound by the terms of this EULA.

1. LICENSE GRANT

S5 Development LLC grants you a license to use one copy of the version of this SOFTWARE on any 
one computer for as many licenses as you purchase. «You» means the company, entity or individual 
whose funds are used to pay the license fee. «Use» means storing, loading, installing, executing or 
displaying the SOFTWARE. You may not modify the SOFTWARE or disable any licensing or control 
features of the SOFTWARE. When you first obtain a copy of the SOFTWARE, you are granted an 
evaluation period of not more than 30 days, after which time you must pay for the SOFTWARE 
according to the terms and prices discussed in the SOFTWARE's documentation, or you must 
remove the SOFTWARE from your system. You are expected to use the SOFTWARE on your system 
and to thoroughly evaluate its usefulness and functionality before making a purchase. The «try 
before you buy» approach is the ultimate guarantee that the SOFTWARE will perform to your 
satisfaction; therefore, you understand and agree that there is no refund policy for any purchase of 
the SOFTWARE after the trial version applying.

2. OWNERSHIP

The SOFTWARE is owned and copyrighted by S5 Development LLC. Your license confers no title or 
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT

The SOFTWARE is protected by copyright law. You acknowledge that no title to the intellectual 
property in the SOFTWARE is transferred to you. You further acknowledge that title and full 
ownership rights to the SOFTWARE will remain the exclusive property of S5 Development LLC and 
you will not acquire any rights to the SOFTWARE. You agree that any copies of the SOFTWARE will 
contain the same proprietary notices which appear on and in the SOFTWARE.

http://www.leo-backup.com
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4. REVERSE ENGINEERING

You agree that you will not attempt to reverse compile, modify, translate, or disassemble the 
SOFTWARE in whole or in part. 

5. NO OTHER WARRANTIES

S5 DEVELOPMENT LLC DOES NOT WARRANT THAT THE SOFTWARE IS ERROR FREE. S5 
DEVELOPMENT LLC DISCLAIMS ALL OTHER WARRANTIES WITH RESPECT TO THE SOFTWARE, 
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD 
PARTY RIGHTS. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES 
OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR 
EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND 
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

6. SEVERABILITY

In the event of invalidity of any provision of this license, the parties agree that such invalidity shall 
not affect the validity of the remaining portions of this license.

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

IN NO EVENT SHALL S5 DEVELOPMENT LLC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF 
THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF S5 DEVELOPMENT LLC HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL SOFTOPTIMA LLC' 
LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY OF LIABILITY, 
EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

Contact information

Technical support	 support@leo-backup.com  

Sales department	 sales@leo-backup.com 

Marketing department	 marketing@leo-backup.com 

Partnership department 	 partners@leo-backup.com 

Press and Public relations	pr@leo-backup.com 

http://www.leo-backup.com
www.s5development.com
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